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            Introduction 

VoxPro6 is used for recording, editing, playing, sharing and managing audio files, 
particularly in broadcast contexts where two-channel (stereo) recording is the norm.  A 
robust file storage system allows files to be stored anywhere on the LAN, accessed from 
any VoxPro computer on the LAN, and shared with any VoxPro user on the LAN. Users 
may keep files around for years and still access them easily at any time for immediate 
playback or further editing.  The optional hardware control panel gives  experienced 
users a powerful tool for making lightning-quick edits in real-time  situations where 
every second counts. 

If during  installation or setup you find that you need assistance or advice,  please 
feel free to contact our technical support folks at (252) 638-7000 or email us at:  
 techsupport@wheatstone.com.

VoxPro6 Software and Control Panel come with a one year warranty.
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Chapter 1. Overview of Main Window Controls

Figure 1.1 shows the main VoxPro6 window in “classic” mode, with the waveform editor 
filling most of the upper half, and the file list in the lower half. In this particular case, a short 
region of the file in the middle of the display has been selected for editing, and is therefore 
highlighted with a pale yellow waveform on a light gray background.

Figure 1.1 – Main VoxPro6 window in Classic mode.

Let’s now take a closer look at the various controls.  
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On the left side of the window (Figure 1.2), we see the length of the selected region in 
the Editor (1.95 seconds), we see that mono-mix playback is enabled, and that Hotkeys, 
Multitrack and Master mode are all toggled off. We also see that we are in Standby mode 
(the other possibilities being Playing, Recording or Scrubbing); and in two places we see 
the name of the file loaded in the Editor: in the title bar at the very top of the window, and 
as a selected item in the File List.

Figure 1.2 – Main window controls, left side.
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On the right side of the window (Figure 1.3), we see a status display in the top right 
corner. If nothing else is going on, it simply gives us a count of the files in the current folder. 
If importing or exporting a file, this display informs us of the progress of that  operation, 
as well as any errors encountered. Immediately beneath the status display is an indicator 
telling us how much total disk space on the current volume is available for new  recordings, 
file imports, etc. Zoom controls in the right margin of the waveform Editor are useful for 
seeing low-level signals better. The classic mode button returns us to this particular layout 
(2-track editor above, file list below) from any other window arrangement, and we see 
that it is engaged. Controls for background editing and recording are located next to the 
classic mode toggle, and are discussed later in this manual.

Finally, at the top of the window to the left of the status display, we see four routing 
controls defined (from a total of eight). These are available only when a WheatNet AOIP 
driver (WDM/DirectSound version) has been installed on the computer. They are usually 
used to select from different sources for recording, but can, in fact, reconnect any source 
to any destination within a WheatNet-IP network, and can also be used to fire Salvos. See 
the Wheatnet‑IP BLADE3 Audio Over IP Network manual for further information.

Figure 1.3 – Main window controls, right side.
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Taking a closer look at the area around the waveform editor (Figure 1.4), we see 
a Timeline tracker immediately above the editable area of the waveform display. The 
 Timeline represents the time span of the file which is in the Editor from beginning to 
end – it is thus a relative scale. It contains a current position indicator (the inverted white 
triangle) as well as any position Markers that might have been inserted (more on these 
later). You may click with the mouse on the current position indicator and drag it left or 
right to relocate your position within the file. Conversely, you may click any place within 
the Timeline to jump immediately to that relative location within the file.

The vertical red cue line in the middle of the waveform Editor represents the current 
play position within the file. Beneath it and to either side are two clocks. The one on the left 
displays the current file position, while the one on the right displays the time remaining to 
the end of the file. Note that the area around the cue line has been selected (highlighted).

Figure 1.4 – Area surrounding middle portion of waveform Editor.
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Chapter 2. Basic Operations

Most editing, playback, scrubbing and recording commands are available on the 
VoxPro6 hardware control panel as well as the computer keyboard. The mouse and main 
menu also provide access to many operations. The list below covers basic editing and 
transport commands. Detailed tables of all control panel and keyboard commands can be 
found in the Appendix.

Playing
There are three flavors of playback: play from beginning, play selection, and play from 

current position. Each of these functions is assigned to a dedicated button on the control 
panel. On the keyboard, the P, S and <spacebar> keys perform the same  functions, 
 respectively. While a file is playing, it can be stopped with either the PLAY button or 
STOP button on the control panel, or the <spacebar> key on the keyboard.  

The Playback Options dialog box, accessible from the main Settings menu, allows 
you to customize a number of features related to playback. You may enable mono‑mix 
playback as the default setting. (Your default setting may be overridden at any time  using 
the mono‑mix button in the left margin of the Editor.) You may hide the mono‑mix button 
in the Editor, thus removing the ability to override the default setting. Playback  direction 
refers to which way the scrolling waveform in the Editor moves as the file plays, right‑to‑left 
being the default. Display headroom is a cosmetic visual setting which affects the scale 
along the vertical axis of the waveform displayed in the Editor.  The effect is to zoom in 
on the vertical axis as the headroom value is increased. [Now the technical explanation:  
the headroom value is the multiplicative inverse of the signal level represented by the 
top edge of (each channel of) the waveform display. A headroom value of 6dB means 
that a signal which peaks at the top edge of the waveform display is still 6dB away from 
saturation or clipping. By default, the full dynamic range is displayed, with the top of the 
display at 0dB full scale.]
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Scrubbing
Scrubbing is the process of moving through a file, either to log what is there, or in 

search of the precise location to commence an edit of some type. In the center of the 
 control panel is an array of six buttons used for scrubbing at different speeds. The top 
pair is fast forward/reverse, the middle pair is normal forward/reverse, and the lower 
pair is slow forward/reverse. These buttons may be held down in combination to toggle 
between speed and direction. For example, you might be holding the fast rewind button 
to locate a position, and pressing the normal speed forward button at various points in 
order to momentarily hear normal playback.

To the left and right of the fast forward/rewind buttons on the control panel are the 
GoToBeginning and GoToEnd buttons. And finally the jog wheel on the right side of 
the control panel can be used across a range of speeds to move quickly or slowly through 
the file in either direction.

On the keyboard, the <left‑arrow> and <right‑arrow> keys perform the basic 
 fast‑forward and fast‑rewind functions. They can be used in combination with the <shift> 
key for normal playback, and with the <ctrl> key for slow playback.

Holding down the <ctrl> key on the keyboard, click and drag the mouse right or left 
within the waveform view to scroll the waveform itself by the same amount.

Scrub behavior in VoxPro6 may be customized to each user’s preference. Open the 
Scrub Settings dialog box from the Settings menu. At the very top is an option which 
makes fast forward/reverse always audible (at 3x normal speed) for as long as one 
of these functions is engaged (or until you reach the beginning or end of the file). If the 
always audible option is not enabled, then you have an option for a two‑stage scrub, in 
which fast forward/reverse is audible at the beginning (at 3x normal speed), and then 
jumps after a specified length of time to a much faster speed which simply scrolls through 
the file without audio playback. Finally, the speed of the non‑audible phase of the scrub 
function may be specified by adjusting the fast forward/reverse speed control.

The Scrub Settings dialog box also lets you invert the combination of <ctrl> key and 
mouse click‑drag in the waveform, giving you the option to scroll through the waveform 
using the mouse without requiring that the <ctrl> key be held down. 

Recording
Press the Record button on the control panel, or R on the keyboard, to start  recording.  

This operation always creates a new file; it never overwrites an existing file. To stop 
 recording, press the RECORD or STOP buttons on the control panel, or the R or 
 <spacebar> keys on the keyboard. At this point a dialog box will appear allowing you to 
name the new file (or accept the generic name) and save it, or cancel it (which just puts it 
in the Deleted Files folder). From the control panel, the OKAY and CANCEL buttons 
perform these functions. On the keyboard, the <enter> and <esc> keys do the same. 
Note that you can cancel a recording at any time by using the CANCEL button or <esc> 
key, in which case the file is closed and moved to the Deleted Files folder immediately.

Insert-Recording
Insert‑record is a specialized function allowing you to insert new audio content into 

an existing file, shoving the remainder of the existing file back from the insertion point.  
(The existing content is not overwritten, it is only moved back by the length of the new 
content.) Insert‑recording commences from the cue line, and can be started while  playing, 
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scrubbing, or stopped. To start, press the INSERT‑RECORD button on the control panel, 
or the I key on the keyboard. To stop, press the INSERT‑RECORD or STOP buttons on 
the control panel, or the I, <spacebar> or <enter> keys on the keyboard. An Insert‑Record 
may be cancelled using the CANCEL button on the control panel, or the <esc> key on 
the keyboard.  A cancelled Insert‑Record cannot be recovered. 

Background Recording
In certain cases, you might need to start recording while VoxPro6 is already engaged in 

file playback, or you might want to access a recording while it’s in progress (for example, 
a long sporting event) in order to extract highlights for immediate broadcast, sharing, 
uploading, etc. In both of these cases, you will be playing and editing in the foreground, 
while simultaneously recording in the background.

While VoxPro6 is playing a file, you may start a record‑
ing in the background by pressing the BG REC button in the 
lower right corner of the Editor pane. Now you may continue 
playback, stop and play other files, fire off Hotkeys, scrub, edit, 
import and  export files; all while VoxPro6 continues recording 
in the background. The only operations you may not perform are 
Record and Insert‑Record (because you’re already recording).

While VoxPro6 is recording a file (in the foreground), you 
may put the recording process in the background by pressing the 
BG REC button. The file currently being recorded is displayed 
in the Editor (now in “playback green”), rolled back 10 seconds 
from the point where the recording was backgrounded, and the 
EDIT BG button is lit.

As long as the BG REC button is lit (red), it means you have 
a recording running in the background. When the EDIT BG but‑
ton is lit (green), it means that the file displayed in the Editor is 
the file which is currently being recorded (in the background). 
As such, you cannot actually edit the file – because it is still 
being written to the disk! However, you may place Markers 
(see Chapter 4) in the file at any location, and you may copy any 
portion of the file into a different file or a brand new file (using 
copy/paste or the New Edit from Selection command), which 
you may then edit and export as you wish. All the while, recording continues  uninterrupted 
in the background.

If you select another file in the File List, that file is loaded into the Editor for playback 
and editing, turning off the EDIT BG button. Click the EDIT BG button again to re‑load 
the file being recorded in the background.

A background recording cannot be stopped until it is returned to the foreground, where 
it becomes a normal recording which can be stopped and named in the normal manner.  
Click the BG REC button while a background recording is in process to bring it into the 
foreground, displaying the incoming signal in the Editor in the usual “recording red” color. 
Stop and name the file at this point if desired, or put it in the background once again by 
clicking the BG REC button.
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Additional Record Options
The default name given to new recordings may be changed in the Record Options 

 dialog box, accessible from the Settings menu. If your VoxPro6 administrator has 
configuredandenabledAutomatic Gain Control, then you may disable or enable that 
process when recording in your own account using the Enable AGC switch.

Auto‑Record is a feature designed for fast call‑in contests, when you want every caller 
in a separate recording, but you don’t have time to name each one. Enable Auto‑Record 
at the very top of the Settings menu. Now each time you start press RECORD (or R 
on the keyboard) the current recording is stopped, given the default name, and a new 
recording is started, creating an automatic “chain” of recordings, all of which appear as 
separatefilesintheFileList.TostopAuto‑Record, press STOP (or <spacebar> on the 
keyboard) at the end of your last call. The record function returns to its normal operational 
mode, so you’ll need to re‑enable Auto‑Record if you want to start another chain of 
recordings. You may keep Auto‑Record enabled at all times by unchecking the Disable 
after stopping option in the Record Options dialog in the Settings menu.

VoxPro6 / Aug 2016
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Chapter 3. Editing and Effects

In VoxPro6, editing operations are applied to the selected region of the active file 
displayed in the Editor, implying that if nothing is selected, then you have nothing to 
edit. This goes as well for the effects listed in the Effects menu, most of which are really 
just various kinds of specialty edits. The selected region may be of any size, up to and 
including the entire file. (The Insert Silence effect and the Paste function are the only 
edit operations which do not require a prior selection, since both are applied regardless 
of length at the location of the cue line.).

Selection
To select a region, use scrub controls to position the waveform so that the left or right 

boundary of the desired region is positioned at the cue line. Press the MARK LEFT or 
MARK RIGHT buttons on the control panel, or the [ and ] (square‑bracket) keys on the 
keyboard.  Reposition the waveform so that the opposite boundary is at the cue line, and 
place the opposite mark. Conversely, you may use the mouse to click‑drag in the  waveform 
Editor directly. The selected region is highlighted by displaying the waveform in pale 
yellow over a light gray background, and the length of the selected region is displayed in 
the indicator in the top left corner of the Editor. Note that you may adjust the left or right 
boundary of the selected region by relocating the waveform relative to the cue line and 
reapplying the left or right mark, as appropriate. Using the mouse, you may right‑click 
within the waveform to change the location of the closest boundary of the selected region 
to the location of the mouse cursor.

You may play the selected region using the PLAY SELECTION button on the control 
panel or the S key on the keyboard.

The selected region may comprise the entire file. To select the entire file from the  control 
panel, apply Mark Left at the beginning of the file, and Mark Right at the end. From 
the keyboard, simply type <ctrl>A, or select the Select All command in the Edit menu.

You may create an entirely new file from the selected region using the New Edit from 
Selection command in the File menu.

The currently selected region may be deselected by pressing the DESELECT button 
on the control panel, the K key on the keyboard, or by using the Deselect command in 
the Edit menu.

Note that you can click the mouse within the waveform to initiate selection, and then 
drag it beyond the left/right margins of the Editor to continue selecting and scrolling in 
that direction. Press and release the PLAY button while scrolling to hear where you are 
while continuing to extend the selection region.

Basic Edits
The selected region may be deleted by pressing the DELETE button on the control 

panel, or the <del> key on the keyboard.
The selected region may be copied (to the clipboard for later pasting) by pressing the 

COPY button on the control panel or the C key on the keyboard.
The cut operation is a combination of Copy and Delete. It first copies the selected 

region to the clipboard, then deletes it from the current edit. Press the CUT button on the 
control panel, or the X key on the keyboard.
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As long as a region has been copied into the clipboard (using either the Copy or Cut 
functions), then you may paste that region into any file, including the one it came from.  
The paste function is always applied at the current location in the file, that is, at the cue 
line.  From the control panel, press the PASTE button, or the V key on the keyboard.

Undo/Redo
Whether applying basic edits or complex effects, all changes may be taken back by 

pressing the UNDO button on the control panel, or the Z key on the keyboard. The Undo 
function is effectively infinite – you can continue to undo your changes (in reverse order) 
all the way back to the original state when the file was first recorded or imported. (It is 
not possible to undo an early edit without also undoing every edit back to that point.) 

You may Redo any Undo or sequence of Undos, returning the file back to state of 
your most recent edit. From the control panel, hold down the OPTION button and press 
UNDO, or from the keyboard with the Y key.  

Master Mode provides a quick shortcut to get back to the original audio data in the 
file, ignoring all edits, undos and redos, and providing access to all audio data in file, 
including anything pasted in from another file, insert‑recorded, or processed through the 
Pitch/Time effect or one of the Advanced Signal Processing effects.  Click the MASTER 
button in the lower left corner of the Editor to toggle Master mode on and off.  (Some 
older models of the control panel also have an EDIT/MASTER button which does the 
same thing.)  While in Master mode, you may not perform any edits or apply any effects, 
but you may select and copy any region for pasting either into the same file (when toggled 
back out of Master mode), or into another file.

Zoom
Press the ZOOM button on the control panel (or the Q key on the keyboard – think 

“magnifying glass”) to toggle between 1x, 4x and 10x zoom along the horizontal (time) 
axis in the waveform Editor. For maximum zoom at the sample level, press both the 
CONTROL and ZOOM buttons on the control panel, or type <ctrl>Q from the key‑
board. Selecting another file automatically resets Zoom to 1x.

Effects
Most of the functions listed in the Effects menu are essentially specialized editing 

operations. All of these with the exception of Insert Silence require a selected region in 
order to be applied. Although the effects are listed in the menu in alphabetical order, let’s 
group them by function instead and take a closer look.

Mute, Fade, Normalize, and Adjust Volume

Effects Which Change Volume

Four of the effects can be used to apply volume changes. Probably the most commonly 
used of these is Mute, which is usually applied to one of the channels, rather than both 
simultaneously. The mute effect is most commonly used for editing phone calls, where 
you want to delete only the caller or only the jock within the selected region. This use 
of mute is so common that there is a shortcut for it built into the control panel: hold the 
CONTROL button down (this is one of the four buttons in the top left corner of the con‑
trol panel), displaying five Effects in the LCD above the hotkeys. The first two hotkeys 
may be pressed to mute the left or right channel, respectively.
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The Adjust Volume effect opens a dialog box which is used to adjust the volume of 
the selected region up or down by 30dB. The volume adjustment will be applied equally to 
both channels if the link button between the left and right trackbars is enabled; otherwise 
each channel may be adjusted independently.

The Fade effect may be used to fade the selected region either up or down. The  effect 
may be applied to both channels simultaneously, or to only one. A cross‑fade effect can 
be achieved by applying Fade‑In to one channel and Fade‑Out to the other over the 
same selection region.

The Normalize effect is used to bring the volume of one or both channels to a 
 pre‑determined maximum level. It is most commonly applied over the span of the entire 
file (either to one channel or to both).

Bleep and Reverse

Effects Which Mask Content

Two of the effects are used to mask content (for example, words or lyrics which may 
not be broadcast over the airwaves). Bleep is the most commonly used of these, and has 
two shortcuts. From the control panel, hold the CONTROL button down, displaying five 
effects in the LCD, then press the middle hotkey to apply Bleep to both channels. From 
the keyboard, simply type the B key.

The Reverse effect is a more subtle effect than Bleep. It simply reverses the audio 
waveform in the selected region, in either channel or both. It is often used in musical 
contexts since it can obfuscate a particular word without changing the pitch or interject‑
ing a 1KHz sine tone.

VoiceSlip, BackSlip, and Channel Paste

Effects Which Change the Temporal Order of Events

Three effects allow you to manipulate the original temporal relationship between the 
left and right channels; that is, to move one of the channels independently of the other.  The 
most common of these is VoiceSlip™, which solves the problem of host/caller talk‑over 
by sliding one of the channels past the other. Figure 3.1 shows a selected region in which 
the caller (left channel) and host talk over each other.

 Figure 3.1 – Selected region highlighting host/caller talk-over.
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VoiceSlip may be used to slide the left channel behind the right, or the right channel 
behind the left. In this case, we choose the “right before left” option, resulting in the altered 
version shown in Figure 3.2.  

 Figure 3.2 – After applying VoiceSlip to host/caller talk-over.

The VoiceSlip effect is also available as a control panel shortcut. After selecting the 
region where you want to apply VoiceSlip, press and hold the CONTROL button to 
display the five effects shortcuts in the control panel LCD. The two right‑most hotkeys 
apply VoiceSlip: Left before Right and Right before Left.

The BackSlip effect is the opposite of VoiceSlip. It creates talk‑over where it did 
not originally exist.  (Your witty comeback can come sooner.) Consider the example in 
 Figure 3.3.  The region encompassing the area in question has been selected:

 Figure 3.3 – Selected region highlighting the area where BackSlip is desired.
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BackSlip can slide the left channel back past the right, or the right channel back past 
the left. In Figure 3.4, we choose to slide the right channel back:

 Figure 3.4 – Choosing which channel to slide back.

After applying the effect, the host (right channel) sounds like he interjects his com‑
ment even before the caller has finished speaking, as seen in Figure 3.5:

Figure 3.5 – Creation of host/caller talk-over after applying BackSlip effect.

Finally, the Channel Paste effect can be used to copy a single channel of audio from a 
given region, then paste it – into the same channel or into the opposite channel – at another 
location within the same file. In Figure 3.6, a music tag at the end of a file has been selected 
as the source. Note that both channels are selected, even though we will be copying and 
pasting just one of them.
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Figure 3.6 – Selected region to be used in Channel Paste operation.

We now relocate the file to the desired insertion point at the cue line, and select the 
desired paste operation (Figure 3.7). In this case, we will paste the content from the left 
channel of the source into the right channel of the destination.

Figure 3.7 – Choosing the Channel Paste operation to be applied at the cue line.

After applying the operation, we see the original left channel of the source is now in 
the right channel of the destination, Figure 3.8:

Figure 3.8 – After applying Channel Paste at cue line. Note left channel remains unchanged.
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Silence Removal (GapBuster) and Pitch/Time Manipulation

Special Purpose Effects

The GapBuster effect is used to automatically remove gaps (silences) in a conversa-
tion or interview, saving you the time and effort editing them out manually. The dialog 
box  allows you to define what constitutes a “gap”. By default, a gap is defined as a span 
of 250ms or longer (the gap length) during which the signal remains below -42dB full 
scale (the gap threshold). You may adjust these values to your own style and ambient 
noise conditions of the recording. A smaller gap (say 100ms) will sound tighter, while a 
longer gap (500ms) allows quite a lot of breathing room. A threshold too high will clip 
off parts of words, while a threshold too low will not remove pauses in conversation 
which contain significant background noise.

There are two keyboard shortcuts for GapBuster. The <ctrl>+G combination is 
equivalent to selecting GapBuster from the effects menu: it opens the dialog box which 
allows you to adjust the gap length and threshold. You may also simply type G alone to 
apply the most recently used GapBuster settings to the selected region.

The Pitch and Time effect can be used for a variety of purposes. It can be used to 
compress or stretch a recorded bit in order to fit it perfectly into a particular span of time. 
(For example, speed up an 18 second ad so that it fits into a 15 second slot.) It can also 
be used as a special effect to raise or lower the pitch of a recording without changing the 
speed. And it can combine these operations, changing both pitch and time simultaneously.

Echo, Reverb, and Simple Signal Processing

Simple Signal Processing Effects

The Windows operating system comes with a small set of standard audio effects built 
in. Two of these, Echo and Reverb have been made available as one-click  operations at 
the very bottom of the Effects menu. A full graphical control interface to both of these is 
also available in the Signal Processing sub-menu, which contains interfaces to several 
other effects as well.
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Chapter 4. Markers

Markers, or bookmarks, are used to mark locations in your files which have special 
significance for you, so that you may access them quickly and easily at a later time. (Do 
not confuse Markers with the Mark Left /Mark Right operations used in selecting an audio 
region for editing.)

Markers may be inserted at any point into any file by typing the M key on the keyboard. 
(There is currently no way to insert a marker using the control panel.) Markers are always 
inserted into the file at the current position (that is, at the cue line). In standby mode, 
inserting a marker brings up a dialog box which allows you to label the marker and as-
sign it a color. The marker is displayed in the Timeline track, its position relative to the 
length of the file as a whole.

Markers may be inserted during recording and playback as well. In these cases, the 
dialog box for the label and color assignment appears, but disappears after a few seconds 
if ignored, leaving a blank marker at the location where the M key was initially pressed.   
(You can always add a label or change the color later on.) Alternatively, you may disable 
the Insert Marker Shows Dialog option (in the Markers menu, or by typing <ctrl>M 
on the keyboard), allowing you to insert markers during playback or recording without 
being prompted to assign a label and color for each and every one.  

Markers inserted into a file are displayed in the Markers menu, whence they may 
be edited or deleted. You may also reposition a marker to a precise location by using the 
Go To Marker sub-menu. VoxPro6 jumps to the location of the selected marker and 
displays its position in the file as a fuzzy vertical line through the waveform. Click and 
drag this line left or right to relocate the position of the marker, then click the small OK 
button which pops up to confirm the change. 

Navigating directly from one marker to the next is easy. From the control panel, press 
and hold the OPTION button while using the Fast Forward/Fast Rewind buttons to 
page forward and backwards through the file’s markers. On the keyboard, the <page 
down> and <page up> keys perform the same function.

Marker labels in VoxPro6 now support the Unicode standard, meaning that mark-
ers may be labeled in any language, using any script (Chinese, Cyrillic, Symbols, etc.). 
 However, this standard is not completely compatible with earlier versions of VoxPro. Vox-
Pro6 files containing Unicode markers will open correctly in earlier versions of  VoxPro, 
but the labels will be illegible and essentially lost. To maintain compatibility with earlier 
versions of VoxPro (at the price of being able to use only 7-bit ASCII characters in marker 
labels), unselect the Unicode Labels option in the Layout dialog box accessible from 
the Settings menu.
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Chapter 5. Hotkeys

Hotkeys offer another way to prepare and organize files for immediate, one‑button 
playback. In Figure 5.1, the Hotkeys panel has been opened by clicking on the Hotkeys 
button (the orange/red bonfire on the left). The active bank of Hotkeys is the one outlined 
in red, and we see that the middle Hotkey in this back is currently playing. The titles to the 
Hotkeys in the active bank are displayed in the control panel LCD, and can be  triggered 
using the corresponding hotkey button. You may also use a regular mouse click to start/
stop a Hotkey in any row. Files loaded into Hotkeys may be any of length, from less than 
a second to several hours.  

Figure 5.1 – Hotkeys panel open in main window, File list moved to the right.

In Figure 5.1, the Hotkeys panel is part of the main window, and forces the File List 
to move to the right side of the window. (There is an option to display the File List on 
the left side instead, in the Layout dialog box accessible from the Settings menu.) The 
Hotkeys panel may also be detached completely from the main window, allowing you to 
display it in a separate window (Figure 5.2), or even on a separate monitor. Use the  Detach 
Hotkeys command in the Views menu to detach (and re‑attach) the Hotkeys window. Note 
that the Views menu also gives you the options to hide the Editor and/or the File List, 
for a variety of usage scenarios.
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Figure 5.2 – Hotkeys panel in separate window detached from main VoxPro6 window.

The Hotkeys panel may contain as few or as many hotkeys as you like. Hotkeys are 
arranged on tab pages in a grid of five vertical columns (corresponding to the five  hotkey 
buttons on the control panel), with anywhere from 2 to 10 horizontal rows per page.  Specify 
the number of rows per tab page required by opening the Layout dialog box from the 
Settings menu.

To add a new Hotkeys tab page, right‑click on any existing tab label and select the Add 
Tab command from the pop‑up menu. Similarly, you may rename or delete a tab. Click 
and drag a tab to reposition it within the tab order.

To load a file from the File List into a Hotkey, simply click and drag the file from the 
List to the desired Hotkey. VoxPro6 creates a separate copy of the file and stores it in a 
secret folder before loading it into the Hotkey.  

To load a file from the File List without changing the active file displayed in the  Editor, 
press and hold the <alt> key on the keyboard before clicking and dragging the desired  
file from the List.

Drag a loaded Hotkey to an empty Hotkey to move the loaded Hotkey. Drag a loaded 
Hotkey to another loaded Hotkey to exchange their positions. Drag a loaded Hotkey up 
to a page tab to open that tab, allowing the file to be moved to any Hotkey on that page.

A left-click on an empty Hotkey prompts you immediately to choose a file from 
 anywhere on the local computer or the LAN and load it.  

A right-click on an empty Hotkey displays a pop‑up menu with a full range of import 
options. For example, you can import the active file (in the Editor) either as a mono mix 
or as a stereo file, and if there is a MultiTrack mix loaded, you may import the entire mix 
or just the title track.  
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A left-click on a loaded Hotkey starts the file playing from the beginning. If you click 
again before the file reaches the end, it will fade out, stop and rewind. The next click will 
start it playing from the beginning. Otherwise the file simply plays to the end, then rewinds 
in preparation for the next start.

A right-click on a loaded Hotkey displays a pop‑up menu from which several options 
may be set, and several functions performed. You may apply a Pad to the Hotkey if the 
playback level is too hot. A mono-mix may be applied if the loaded file is not already mono 
summed. The fade‑out length applied when playback is stopped before reaching its end 
may be customized between four different settings. Functions include edit, copy, paste, 
delete, and rename. (Paste is enabled only if you have previously copied another Hotkey.)  

The edit function opens the floating Side Editor, shown in Figure 5.3. While the Side 
Editor is open, all keyboard and control panel commands are routed to it, rather than to the 
main window. The Edit and Effects menus in the Side Editor replicate most of the same 
functions familiar from the corresponding menus in the main window. Any change (edit, 
rename, pad, fade, etc) applied to a Hotkey affects that Hotkey only and not the original 
source it was copied or imported from.

Finally, the Playback Device function at the bottom of the right‑click pop‑up menu 
allows playback from a given Hotkey to be assigned to a particular audio device, to enable 
special routing or processing independent of the main audio output.

Normally you may play as many Hotkeys as you like, simultaneously and indepen‑
dently. To change this behavior, enable the new Hotkey stops current Hotkey option 
in the Playback Options dialog box which is accessible from the Settings menu. When 
this option is enabled, any currently playing Hotkey will stop playing whenever a new 
Hotkey is started.

Figure 5.3 – Editing a Hotkey using the floating Side Editor.
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Chapter 6. MultiTrack Editing

Click the MultiTrack button to toggle the Editor into MultiTrack view (Figure 6.1).  
The active file is now displayed in the top track, also called the title track. The width 
of the display represents the length of the title track from beginning to end. In this ex-
ample, a second support track has been added: a music intro. Note that its position in 
the  composite mix precedes the beginning of the title track.  

In the File List, an icon now appears in the left-most column next to the file name; this 
indicates that the file contains MultiTrack content. Even if the Editor is toggled back to the 
normal 2-track mode, the composite multitrack mix will be played when the file is played.

Figure 6.1 – The Editor in MultiTrack mode. A music intro starts before the main voice track.

To add support tracks, press and hold the <alt> key on the keyboard while dragging a 
file from the File List into the MultiTrack view.  Alternatively, right‑click in any blank area 
of the MultiTrack view to open a file import dialog.  You may also drag Hotkeys directly 
into the MultiTrack view.

Click and drag support tracks to the left or right to realign them within the composite 
mix. In this example, the music intro has been dragged to the left, past the beginning of 
the title track, thus inserting an automatic delay before the title track begins to play.

Left‑click any support track to play it by itself.  Click again to stop.
Right‑click any support track to display a pop-up menu of options. You may pad the 

track in 1dB increments, you may nudge the track left or right in 50ms increments, you 
may delete the track, and you may edit it in the same manner as Hotkeys, in the floating 
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Side Editor. As with Hotkeys, changes made to support tracks do not affect the original 
files they are derived from.

Individual physical tracks in the MultiTrack view may be muted using the mute 
switches located in the margin to the right of each track. The lock switch to the right of 
the title track locks the entire composition, preventing any inadvertent changes you might 
make without noticing. Note that the mono-mix indicator still appears in the left margin 
next to the title track, and functions identically as in 2-track mode.

If you need more physical tracks for a particular composition, use the Add Support 
Track command in the main Edit menu. If you would like to change the default number 
of physical tracks displayed in MultiTrack view, change the Support Tracks value in the 
Layout dialog box accessible from the Settings menu.

A MultiTrack mix may be bounced to a single file by using the Render Multitrack 
Mix command in the File menu. The file is given the same name as the title track (ap-
pended with “mix”) and appears in the File List next to the original.

A MultiTrack mix may also be exported using the normal Export command in the 
File menu. Support tracks will be included in the mix if this option is selected in the 
Export dialog box.

If the Hotkeys panel is open, then the MultiTrack mix may also be imported directly 
into any Hotkey using the right‑click pop‑up menu of the Hotkey itself.
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Chapter 7. Import and Export

You may import audio files (MP3s, Waves, etc) created outside of VoxPro using the 
Import command in the main File menu. If you discover a file format which cannot be 
imported, contact your system administrator and ask for the Combined Community Codec 
Pack to be installed. This is a set of freely available codecs which provide  Windows with 
the native ability to import many different file types. You can find a link to the CCCPack 
on the Wheatstone website.

Use the Import in Background command in the File menu if you have many long 
files to import and you need to continue working in VoxPro6 while the import process 
takes place. This can take an especially long time if a format conversion is required in 
order to render the file correctly using VoxPro6’s default sample rate. (See the VoxPro6 
Admin Guide for details on audio device and format settings.)

Auto-Import is a feature which automatically imports audio files which appear in a 
specified folder on your local computer or on the LAN. Enable Auto-Import in the Import 
Options dialog box available from the Settings menu, specifying both the source folder 
which VoxPro6 is to montor, as well as your own destination folder into which the files 
will be copied. Use a UNC path for the source folder if you will be using the Auto-Import 
feature from remote VoxPro workstations.

You may export files to Wave or MP3 format using the Export command in the main 
File menu. Note that you have a range of choices in how to export the file, including 
swapping channels, condensing to a mono mix, leaving out one channel, etc. You may 
export a file to any folder on your local computer or on the LAN.

EZ-Export is a useful feature if you find yourself continually exporting files to a 
particular destination and in a particular format. Configure EZ-Export from the Settings 
menu. You specify a destination folder as well as a format. Henceforth, you can export 
any selected file to that location with one mouse click, either by using the EZ-Export 
command in the main File menu, or by right-clicking the file in the File List.

You may use the Archive command in the File menu to copy the selected file(s) to a 
backup location on your LAN. This is different from exporting because the actual VPW 
file that VoxPro6 uses is copied, thus maintaining the entire edit history.
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Chapter 8. Files and Folders

Every VoxPro user account comes with three standard folders in which files are (or 
may be) stored.  These are the Default folder, where you’ll be working unless you specify 
otherwise; the Transfer folder, which is your “in-box”, the place where files appear which 
are sent to you by other users; and the Deleted Files folder, which is where cancelled 
recordings and deleted files go until you really, truly, irrevocably delete them. 

To create additional folders use the Add Folder command in the Folders menu.  Use 
the same menu to switch between folders, and to delete and rename folders.

Right-click on any file in the File List to bring up a menu with options for various 
commands related to the file as a whole. The Copy command creates a copy of the file 
within the same folder. The Copy To command lets you make a copy of the file to any of 
your other folders, or to any other VoxPro user on the local computer or the LAN. Files 
copied to other users appear in the Transfer folder of that user. The Move command can 
be used to move the file to any of your other folders. The Delete command simply moves 
the file to your Deleted Files folder. Delete, Export, EZ-Export, Rename and New Edit 
from Selection are convenience commands which are also found in the main File menu.

VoxPro uses a semi-proprietary file format called VoxPro Wave, or VPW. The 
VPW format is identical to the standard RIFF Wave format, except for the inclusion of 
an  additional RIFF chunk in which VoxPro stores information about the edits (changes) 
you’ve made to the file. In extraordinary circumstances (for example if something in the 
file get corrupted and VoxPro is unable to open it as a VPW file), then you can change the 
extension on the filename from “.vpw” to “.wav” and then import it as a standard Wave 
file. Note that this has the effect of ignoring all edits that might have been made to the 
file: you are, in effect, returning the file to its original state.

At times you or a co-worker may use Windows File Explorer or a similar utility to 
delete files from one of your folders, or to add files from elsewhere, without going through 
the “proper channels” within VoxPro. In these cases, the database that VoxPro maintains 
for that folder will be out of sync with the actual contents of the folder. Thus, for example, 
a file which appears in the File List might not actually be on the disk, or a file which is 
physically present in the folder might nonetheless not appear in the File List. To resolve 
these conflicts, use the Rebuild File Database command in the main File menu to resyn-
chronize the database for the current folder.   

Keep in mind that the more files there are in a folder, the more time required to list 
them and to maintain a coherent database. We recommend around 2000 files per folder as 
a good working limit. More than that and you’ll probably start to notice how much longer 
it’s taking to log in, or to switch to that folder. We have seen one user with over 12,000 
files in one folder, however, so the actual limit is probably quite high.  

You may use the Search command in the File menu (or type <ctrl>S on the keyboard) 
to locate files within your own folders as well as other users’ folders. The Search function 
also lists Hotkeys which match the search parameters. Files for which you do not have 
write permission are highlighted in light red.  Otherwise, you may copy, move, delete, 
rename or edit any file returned in the list. Double-click any file in the list to play it.
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Chapter 9. Miscellaneous Settings

Meters
Several options pertaining to the location and operation of the peak program meters 

are available in the Meters dialog box in the Settings menu. The meter style (LED or 
continuous) and dynamic range can be customized, as well as an option to deactivate 
meters when not playing or recording. The meters may be displayed vertically, to the right 
of the File List (the default, classic arrangement); or horizontally, beneath the waveform 
display in the Editor.

Touch Controls
An option to display on-screen touch controls for Play/Stop/Record/Scrub functions 

is available in the Layout dialog box in the Settings menu. These controls are intended 
for operation on tablets and other touch-screen devices where other options for basic 
control are limited.

Font Size
The size of the font used in the File List and on Hotkeys may be increased or decreased 

from within the Layout dialog box in the Settings menu.

Password
You may password-protect your VoxPro user account by assigning a password using 

the Change Password dialog box in the Settings menu.  

VoxPro Control Panel
Normally there is only one hardware control panel attached to the computer, but 

you may actually connect up to four controllers to a single VoxPro computer – useful in 
situations where two or more team members run a show sharing a single computer with 
multiple monitors.  

If the control panel appears to not be functioning (but the software itself is), open the 
Control Panel dialog box in the Settings menu. If a control panel is present, the option 
to use the control panel should be checked. Check the serial control panel attached 
option only if there is a serial (RS-232) controller connected to a COM port. (These are 
increasingly rare on modern computers.) If closing the dialog box using the Reset and 
Close option does not revive the connection, try it again using the Cycle Ports option. 
Allow a couple of seconds after this maneuver for the connection to the control panel to be 
re-established. If the controller is still unable to connect, contact your VoxPro administrator.

The Control Panel dialog box also provides two options to reassign certain buttons 
on the controller so that they perform different functions. These options are intended for 
an older version of the control panel called the RC-400, which had a different button 
layout than the current RC-500 control panel.

Disable Remote Control
If your administrator has enabled remote control functions of any sort, you may  disable 

them from the Remote Control dialog box in the Settings menu. There are separate op-
tions to disable contact closures detected at the control panel’s D-sub (DE-9) port, and 
to disable software logic signals, both incoming and outgoing.
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Appendix 1. Control Panel Button Combos
The buttons on the control panel are for the most part well marked except for the Bank 

Select buttons, which are primarily used to change the active Hotkey bank, and the List 
Scroll buttons which provide the primary means of scrolling through the File List (see 
Figure A1).

Several of the buttons on the control panel perform special functions when used in 
combination.

Fast Scrub buttons
•	 with Shift: cycle through tab pages in Hotkeys Panel
•	 with Option: go to next/previous Marker.

Bank Select buttons
•	 with Shift: cycle through tab pages in Hotkeys panel.

Control button
•	 press and hold to display Effects shortcuts in LCD (only with selected region in 

Editor).

Undo button
•	 with Option: Redo.
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Zoom button
•	 with Control: set waveform display to maximum zoom.

Go To Beginning button
•	 with Option: Go to End  (used on older control panel models).

Go To End button
•	 with Option: Go to Beginning  (used on older control panel models).
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Appendix 2. Keyboard Shortcuts

KEY FUNCTION FUNCTION WITH CONTROL KEY

A Select entire file (All) Select entire file (All)
B Bleep selected region Bleep selected region
C Copy selected region Copy selected region
D Delete selected file(s)
E Export selected region
F EZ-Export selected region
G Apply GapBuster Apply GapBuster
H
I Insert-Record Import
J
K Deselect Deselect
L Logout
M Insert Marker Toggle Insert-Marker-Shows-Dialog
N New Empty File
O Toggle mono-mix playback Normalize selected region
P Play from beginning
Q Cycle through zoom Maximum zoom
R Record
S Play selected region Open Search dialog
T Empty deleted files folder (Trash)
U
V Paste Paste
W Toggle Master mode Toggle Master mode
X Cut Cut
Y Redo Redo
Z Undo Undo

[ Mark Left (selection region)
] Mark Right (selection region)
>  (.) Fade out selected region
<  (,) Fade in selected region

VoxPro6 / Aug 2016
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KEY FUNCTION FUNCTION WITH CONTROL KEY
Escape Cancel (recording or dialog box)
Home Go to beginning of active file
End Go to end of active file
Page Up Go to previous Marker
Page Down Go to next Marker
Delete Delete selected region
Left Arrow Fast forward Slow forward (normal with shift key)
Right Arrow Fast reverse Slow reverse (normal with shift key)
Up Arrow Scroll up in File List
Down Arrow Scroll down in File List
Backspace Delete Selected Region
Space Play from cue, stop
Enter Play from cue, stop

These key shortcuts are available from the number pad (numpad), with NumLock 
engaged:

9 Fast forward
8 Fast reverse
6 Normal speed forward
5 Normal speed reverse
3 Slow speed forward
2 Slow speed reverse
/ Mark Left (selected region)
* Mark Right (selected region)
- Go to end / Go to beginning
+ Record
Enter Play from cue, stop
. Delete selected region
7 Play from beginning
4 Play selected region
1 Cancel
0 Insert-Record
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